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Contact and Support Information
Product and account information can be accessed by visiting Customer Support online at
Support.CCH.com. In addition to product and account information, the Customer Support site
offers answers to our most frequently asked questions, forms release status, Knowledge Base
articles, training videos, and operating systems compatibility. Access to these features is available
24/7.

The following Web site provides important information about the features and updates included in
all CCH® ProSystem fx® Tax releases: Release Notes

Visit the Application Status Web page to view the current status of our CCH applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find information on topics such as Sales and Billing, as well as options to Open
a Support Case or Chat with a Representative if you need assistance.

Information in Tax Year 2016 Release Notes
Tax Release Notes inform you of the enhancements and updates that have been made to Tax
products and systems with the current release.

Updates provided in the Release Notes include the following:

Contact and Support information
Updates to the Tax technology (electronic filing updates, Pro Forma/Roll Forward,
Organizer, technology enhancements)
Updates made to Tax products (form additions and updates, diagnostic updates, changes
caused by regulatory updates)
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https://support.cch.com/
https://support.cch.com/updates/Tax/releasenotes.aspx
https://support.cch.com/notes/appStatus.aspx?prodid=806
https://support.cch.com/Contact


Upcoming Releases
Return to Table of Contents.

Electronic Filing
Electronic filing is scheduled to be available in January 2017 for the following products:

Individual
Corporation
Employee Benefit Plan
Fiduciary
Partnership
S Corporation
Exempt Organization
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Highlights for Release 2016.01010

CCH® ProSystem fx® Tax Updates

Changes to User Logins:

Users can now save their User ID in the Login window.
Locked users can answer their security questions to unlock their account, and then can reset
their password.
Users will now see added text on the Login window warning them that Caps Lock is on in the
password field.
Users now have an option to show the password (rather than asterisks) by selecting the new
Eye icon next to the password.
Revised text on the Login window to say "Change Password" rather than "New Password.”
Increased the number of allowed password attempts from three to five.
After entering an invalid password in the Login window, the following text displays, "Your
User ID or Password is incorrect. You have 4 more failed attempts before your account is
locked."

CCH® Global fx Tax Updates

Changes to Login Window and Bookmark:

Users can now save their User ID in the Login window.
Locked users will now be provided a link to reset their password.
Addressed an issue where bookmarking of the login page did not take the user to the correct
location. After logging in, the user may select a link to access the application they intended
to access.
Increased the number of allowed password attempts from three to five.
Added the following clarifying text to the Login window, which will allow administrators to
unlock their accounts without calling support, "The administrator within your firm can log in
to admin.prosystemfx.com to unlock their login or reset their password."

An issue was corrected with printing to PDF where only the C drive was available. With this release, all 
drives will be available for selection.
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Tax Product Enhancements in Release 2016.01000
Click one of the links below to read about the tax application enhancements included with Release
2016.01000.

Worksheet View
Individual (1040) Product Enhancements - Worksheet View

Partnership (1065) Product Enhancements - Worksheet View

Corporation (1120) Product Enhancements - Worksheet View

S Corporation (1120S) Product Enhancements - Worksheet View

Fiduciary (1041) Product Enhancements - Worksheet View

Employee Benefit Plan (5500) Product Enhancements - Worksheet View

Exempt Organization (990) Product Enhancements - Worksheet View

Estate and Gift (706/709) Product Enhancements - Worksheet View

Interview View
Individual (1040) Product Enhancements - Interview View

Partnership (1065) Product Enhancements - Interview View

Corporation (1120) Product Enhancements - Interview View

S Corporation (1120S) Product Enhancements - Interview View

Fiduciary (1041) Product Enhancements - Interview View

Employee Benefit Plan (5500) Product Enhancements - Interview View

Exempt Organization (990) Product Enhancements - Interview View

Estate and Gift (706/709) Product Enhancements - Interview View
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Tax Product Enhancements 2016.01000 - Worksheet View

Individual (1040) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information.

IRS Fraud Prevention
An ID type field is now available to indicate driver’s license or state issued ID.

Federal Links Worksheet
We added “Autoflow” and "Date Calculated" to the worksheet to be easily used in the DataScans
created (Summer 2016).

Amortization Report
We added a new amortization report for 1040 (already available for business systems).

Wages Statement
The wages statement now includes a statement reference number on Form 1040, Line 7.
Previously, no statement reference printed (Summer 2016).

Expatriate Wages
We added fields for work days/hours in a city as well as dates worked to properly flow to the city
returns.

Gains

We added a column for "Quantity" after the "Description" column. This allows you to import
and export the number of shares from a Microsoft® Excel® file. We will put the number back
in the description field on the tax form.
We added fields for state ID numbers.
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Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Depreciation Department Number is now four characters (was two).

Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages – 114, 2848, 8879, 3520, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.

Extensions
We moved the "Extensions" section to its own category; which is now the second item on the
menu.

New Drill Downs
We added drill downs for:

Page 1 Line 10, Taxable refunds, credits, or offsets of state and local income taxes
Page 1 Line 21, Other Income - as this line can have items that come from many different
entries
Page 1 Line 44, Tax
Form 6251, Line 27, Other adjustments, including income-based related adjustments

Consistency/Usability Initiative Changes

We added IRS Form names to menu for search ability.
We revised the menu for logic and consistency.
We moved Extension in the menu to second after General.
We added summary grids to State Estimate Payment and State Extension Payment sections.

Worksheet Navigation

We broke up income and deductions into separate sections.
We added Social Security income as its own node at the same level as Other Income.

1040NR, U.S. Nonresident Alien Income Tax Return

We added e-file (which entails input and output changes to Form 1040NR, Form 8840, and
Form 8843).
We added a check box that when checked will add the text “Not present in U.S. -No U.S.
immigration status” to Page 5, Line E, Immigration Status. Per the IRS, this is the required
text if the taxpayer was not present in the United States on the last day of the tax year, and
has no U.S. immigration status.

Tax Product Enhancements 2016.01000 - Worksheet View • 7



New Forms

Form 8854, Initial and Annual Expatriation Statement.
We will add with limited calculations only.

Includes electronic filing.

Form 8830, Enhanced Oil Recovery Credit
Form 8974, Qualified Small Business Payroll Tax Credit for Increasing Research Activities

Supporting Statement
We now provide a statement for Line 65, 20xx estimated tax payments and amount applied form
20xx return (prior year return) (1040 and 1040NR).

Revised Footer
When there is a statement for interest and penalties, text will print at the bottom of Form 1040,
Page 2. It will indicate the total amount due, including interest and penalties.

Revised Forms

Form 8867. Paid Preparer's Earned Income Credit Checklist is revised and renamed. The
changes are a result of the expansion of paid preparer's due diligence requirements to cover
the Child Tax Credit, the American Opportunity Education Credit, and the Earned Income
Credit.
Form 8958. Allocation of Tax Amounts Between Certain Individuals in Community Property
States allows you to report every W-2 source AND split each.
Form 8965. Input from the IRS 1095-A will be used in the calculations determining total
months of coverage for the tax household.
1099-MISC Summary Grid. We added all possible additional income fields to the Summary
Grid for the 1099-MISC. Example – rents, royalties, and nonemployee compensation.
Pro forma. We added the "Delete from pro forma option" for Forms 1098 Mortgage Interest
Statement and Forms 1099.
PTP. Allows for aggregation of PTP K-1s, which will offset gains and losses from different
entities in one PTP.
Passthroughs. We added fields for Section 59(e)(2) expenditure carryovers.
Investment management fees. The description now appears as “Payer Name – Investment
Expenses” when an amount is entered in the investment expenses field on 1099-INT, 1099-
DIV and Consolidated 1099 input.

Schedule B

Three fields are available for tax-exempt interest. The field on the IRS 1099-INT is used for
the federal return and two other fields are available for tax exempt interest that is state
nontaxable and state taxable. When an entry is made in one of the state fields, the other
field is auto-filled with the difference between the federal and state amount.
The IRS 1099-DIV uses the same approach.
In response to a change by the IRS, a field is added for bond premium on Treasury
obligations. As a result, amounts of bond premium are no longer allocated to interest from
Treasury obligations.
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Form 8621, Information Return by a Shareholder of a Passive Foreign Investment
Company or Qualified Electing Fund

We added the following:

The option to code 8621 income as dual status so that it will flow to the 1040 statement.
Additional detail input for prior year amounts on Form 8621.
A grid to 8621 - Return by a Shareholder of a PFIC or QEF > Distributions/Dispositions from
Section 1291 Fund to allow import and export of data.

Diagnostic
We added a diagnostic for an automatic sale when business use % is entered. This will alert you
that the cost basis will flow to Form 4797 at 100%, as opposed to some business use %. When the
matching sale number is used and "percent to be excluded" is entered for depreciation, the percent
is not applied to the "cost or other basis" of the asset.

Tax Equalization
We added the following:

An override for US hypo wages: Foreign > Expatriate Wages > - US hypothetical Comp -
override
Overrides for all Form 8959 lines
Pennsylvania cities

IRS Processing Notes

Form 8812. Returns may be filed and will be processed by the IRS when the filing season
opens, but refunds containing earned income credit (EIC) or additional child tax credit
(ACTC) will not be issued until February 15, 2017.
Form 8885. The health coverage tax credit (HCTC) can no longer be taken for health plans
offered through a Health Insurance Marketplace. Monthly advance payments of the HCTC
have been implemented on a limited interim basis. The IRS expects to fully implement the
program in January 2017.
Form 8941. The credit for small employer health insurance premiums may only be claimed
over two consecutive years. If the credit was claimed in 2014, it cannot be claimed for
2016.

Organizer
Alphabetize K-1s on Organizers. Default is to alphabetize.

States

We added automatic Foreign Tax Credit calc to applicable states.
Allow only for Canadian Province: MA, MI, MN, NY, VT

Allow for foreign countries: AL, AZ, IA, IN, KS, MT, NC, NM, VA

Allow to state, territory of US possession: CO, DC, ID, IL, MD, MS, ND, OR, UT

We standardized automatic inclusion of nonresident state return for e-file when applicable
for resident credit for taxes paid.
We added the ability to e-file state estimate payments for:

DC, NY, NYC, TN FAE-172
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Deleting a state from a return will retain the state taxes paid for Pro Forma purposes, making
them available for next year’s Schedule A deduction.

Alabama
We added AL COA - Change of Address Form.

Arizona
We added AZ 352, Credit for Contributions to Qualifying Foster Care Charitable Organizations.
Input is on Arizona, Credits > Contributions to Qualifying Foster Care Charitable Organizations.

Arkansas
We added the following:

AR EST PMT, Estimated Tax Payment Bank Authorization for Direct Debit
AR TAX PMT, Income Tax Payment Authorization for Direct Debit

California
We added the following:

CA 8453(PMT) – Payment for Automatic Extension and Estimate Payment Authorization for
Individuals
CA 8879(PMT) – Electronic Funds Withdrawal Payment Signature Authorization for Individuals
and Fiduciaries
CA LLC-12NC, Statement of No Change
Direct debit of extension payments
2D barcode (540NR)

Colorado

We added the following:
104AD, Subtractions from Income

104CH, Voluntary Contributions Schedule

104US, Consumer Use Tax Reporting Schedule

2D barcodes are now mandated.

Connecticut
We now flow the Property Tax from federal for Property Tax Credit purposes.

District of Columbia
We added D-40WH, Withholding Tax Schedule.

Georgia

We added the following:
CR-207, Rural Physicians Credit

CR-208, Adoption of a Foster Child Credit
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CR-209, Eligible Single-Family Residence Tax Credit

Supplemental W-2, Income Statement Details

2D barcode (500 and 500X) are now mandated.

Hawaii
We added N-311, Refundable Food/Excise Tax Credit.

Indiana
We added Schedule IN K-1, Shareholder’s/Partner’s Share of AGI, Deductions, Modifications and
Credits.

Iowa
We added the following:

100A, Capital Gain Deduction – Livestock
100B, Capital Gain Deduction – Real Property, Farm
100C, Capital Gain Deduction – Real Property, NonFarm
100D, Capital Gain Deduction – Timber
100E, Capital Gain Deduction – Business
100F, Capital Gain Deduction – ESOP

Maryland
We added the following:

548, Power of Attorney. Input is on Federal, Power of Attorney worksheet
502R, Retirement Income

Massachusetts

Returns may allow PDF attachments.
We added M-8379, Nondebtor Spouse Claim and Allocation for Refund Due.
We added Sch OJC, Income Tax Paid to Other Jurisdictions.

Michigan
We added 5472, Direct Debit of Individual Income Tax Payment.

Michigan – DTW
We added the following:

Part-Year Resident Income Tax Return
CF 1040X, Amended Individual Tax Return
CF 1040XPV, Amended Income Tax Return Payment Voucher

Minnesota
We added the following:

A statement on the MN return that shows how the pass through income is calculated when
there are suspended losses.
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M1REF, Refundable Credits.
M1PSC, Credit for Parents of Stillborn Children.

Mississippi
We added 80-360, Catastrophe Savings Tax.

Missouri - Missouri Kansas City
We added the following:

RD-108, Payment Voucher
RD-109, Payment Voucher
Electronic Filing of Form 108 and Form 109

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added IT-639-ATT, Eligible Employee Information for the Minimum Reimbursement Credit.

New York City
We added ability to generate multiple Declaration of Estimated Tax (vouchers 2,3, and 4).

Ohio

We added IT/SD 2210-100 ANN INC, Annualized Income Worksheet.
We added Separate School District Return Summaries.
We separated School District Letters/Filing Instructions.

Oregon
We added the following:

40-EXT, Extension of Time to File and Voucher
Schedule OR-ADD-DEP, Additional Dependents
Diagnostic alerting to possibility of using OR-PTE
Calculation of Special Medical Subtraction from FD numbers
Automatic carryforwards of prior year credits

Oregon – MUL
We added electronic filing.

Pennsylvania

We removed RCT-101 forms.
We added PA-40 Sch P, Refund Donations to 529 College Savings Program Accounts.

Pennsylvania – Pennsylvania Cities
We added TEQ.

Tax Product Enhancements 2016.01000 - Worksheet View • 12



Pennsylvania – Philadelphia

We added electronic filing for Form S1.
We pulled Expat wages to Form AR/WTR.
We added TEQ.

Tennessee
We added the following:

RV-F1307901 (Certification), Franchise and Excise Tax Exemption
FAE 172 and EF
2D barcode

Texas
We added 05-158-B FINAL, Franchise Tax Report.

Vermont
We added EF extensions.

Wisconsin
We added the following:

Schedule BD, Business Development Credit
Schedule QI, Sale of Investment in a Qualified WI Business
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Partnership (1065) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Federal Links Worksheet
We added "Date Calculated" to the worksheet to be easily used in the DataScans created.

Schedule K-1

We added the option to suppress Schedule K-1 on a Partner by Partner basis.
We added ratio ID Numbers to Passthrough Input for Allocations.
We added an option to Prepare Simplified Increase/Decrease Reconciliation Statement for
Schedule K-1, Item L.
We added an open line item input for Line 13R, Pensions and IRAs.

Apportionment
We added a Zero Apportionment option for state and city returns.

Gains
We added a column for "Quantity" after the "Description" column. This allows you to import and
export the number of shares from a Microsoft® Excel® file. We will put the number back in the
description field on the tax form.

Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Depreciation Department Number is now four characters (was two).

Extensions

We moved “Extensions” from the “Other” category to its own category; this is now the
second item on the menu.
The mailing address now prints at the bottom of federal extensions.
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Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages – 114, 2848, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.

Consistency/Usability Initiative Changes

We revised the menu for logic and consistency.
We moved Extension in the menu to second after General.
State Composite and State Adjustments categories in menus are now collapsible.

New Forms
We added the following:

8830, Enhanced Oil Recovery Credit
1128, Application to Adopt, Change or Retain a Tax Year

States

We added the ability to e-file state estimate payments for:

Minnesota Tennessee

We added Form 8879-SO, State Signature Forms for:

Connecticut New Jersey
Delaware New Mexico
Idaho North Dakota
Illinois Rhode Island
Kansas South Carolina
Maine Tennessee
Michigan Texas
Minnesota Utah
Missouri West Virginia
Nebraska Wisconsin
New Hampshire

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

District of Columbia

Nebraska

North Carolina

Oregon Tri-Met and LTD

South Carolina

Arkansas
We added additional supporting statements to Arkansas Schedule K-1.
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California
We added the following:

California Form 593, Real Estate Withholding Tax Statement
California Form 588, Nonresident Withholding Waiver Requests

Georgia
We added Form G-7 NRW, Nonresident Withholding Return (added Summer 2016).

Illinois
We added Crossover functionality Unitary Partnership returns (added Summer 2016).

Maine
We added Form 1099ME, Pass-Through Withholding.

New York
We added the following:

IT-241 - Claim for Clean Heating Fuel Credit
IT-242 - Credit for Conservation Easement Tax Credit
IT-634 - Empire State Jobs Retention Program Credit
IT-641 - Manufacturer's Real Property Tax Credit
IT-635 - Urban Youth Jobs Program Tax Credit
IT-646 - Employee Training Incentive Program Tax Credit
IT-636 - Beer Production Credit
IT-642 - Empire State Musical and Theatrical Production Credit
IT-603 - Claim for EZ Investment Tax Credit and EZ Employment Incentive Credit

Oklahoma
We added Form 504-C (EXT) - Application for Extension of Time to File Income Tax Return.

Nevada
We added the Nevada Commerce Tax (Summer 2016).

Ohio

We removed Form CAT-12.
We added 2D barcodes.

Pennsylvania
We removed RCT-101 forms.

Rhode Island
We added 2D Barcodes.
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Wisconsin

We changed Form 3 and Form 3K-1 back to portrait format.
We added Schedule BD, Business Development Credit.
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Corporation (1120) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal

Forms 1120 Series Filing Due Date Changes

The Federal government has changed the return due dates and extended filing dates.
Effective for tax years beginning after December 31, 2015 C corporations must file by April
15 following the close of the calendar year or the 15th day of the 4th month following the
close of the fiscal year. A C corporation with a June 30 year end must file by September 15.
The extended due date is September 15 for a calendar year; April 15 for a fiscal year ending
on June 30; and the 15th day of the 10th month for all other fiscal years.
The new due dates apply to forms 1120, 1120-F, 1120-RIC, 1120-REIT, 1120-POL, 1120-SF
and 1120-H.

Late Filing Penalty Changes
The minimum late filing penalties for federal returns filed more than 60 days late have been
increased. The penalty the greater of (a) $205 or (b) 100% of the tax due. This provision applies to
returns filed after 12/31/2015.

Form 1120, Page 4, Schedule K
Line 19 “During the corporation’s tax year, did the corporation make any payments that would
require it to file Forms 1042 and 1042-S under chapter 3 or chapter 4 of the Code” has been added
to Schedule K. The same question is added to Form 1120-F, page 2, Additional Information, Item
BB.

Form 1120-F

Form 1120-F is now an 8 page form. Page 1, items H through M have been moved to page 2.
Item W(2) :Is the corporation claiming treaty benefits pursuant to a Competent Authority
determination” has been added to page 2.
Page 2, Section I has been moved to page 3, pages 4 through 7 become pages 5 through 8.

Form 1120-F, Schedule I
Use Worksheet View Other Returns > 1120-F > Schedule I – Interest Expense Allocation Under Regs
> Summary to override the disallowed passive interest expense and deferred passive interest
expense allowed from Form 8810 reported on Schedule I (Form 1120-F), lines 24a and 24b
respectively.

Form 8288-A and Form 8805
These two forms are added to Form 1120-F only and for e-filing requirements. In prior years the
IRS allowed both forms as a PDF attachment, both forms are now required in XML format.

Form 1120-RIC
New lines 5 through 8 have been added to page 2, part II to compute the alternative timber gain
tax. Part II now reports qualified timber gain on line 4.
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Form 1128
Form 1128, Application to Adopt, Change, or Retain a Tax Year, is prepared from input on
Worksheet View Other > 1128 > Part I, General Information through Part III, Ruling Request.

Form 3800
Line 1zz on page 3 is used to report the enhanced oil recovery credit (Form 8830). Line 4i on page
3 has been activated for increasing research activities credit (Form 6765).

Form 7004
You can select the new option “Print IRS mailing address on federal extension” on Worksheet View
Extensions > Federal Extension > Line 22, to Print IRS mailing address at the bottom of Form 7004.
An Office Manager option is also available.

Form 8830

The Enhanced Oil Recovery Credit form has been added to the program.
Schedule D, Part IV has been added to page 2 devoted solely to timber gain tax. The
qualified timber gain is calculated from detail entries on Worksheet View Income/Deductions
> Gain and Losses, with property type “CAP”, “1231”, “1245”, or “1250” and Schedule D
Options of “20.” Use Worksheet View General > Basic Data > Miscellaneous Information >
Qualified timber gain - override.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Schedule D/Form 8949

Input has been added for “Quantity” of shares.
Schedule M-3. Schedule M-3 designation codes “SL”, “AC” and “SA” have been added for
rental and farm activities.

Schedule M-3, Part II, Lines 1 through 8
We will now produce a supporting statement for each of the lines 1 through 8 on Part II.

Passthrough (C Corp only)
Passthrough open line input for Other Income and Deductions on Worksheet View
Income/Deductions > Fiduciary Passthrough or Partnership Passthrough > Other Income and
Deductions is now available for C Corps

Carryover Information Suppression
The General Carryover Data report and the Detail Carryover Schedule will be suppress when the
option to “Suppress Pro Forma Processing” is selected on Worksheet View General > Return Options
> Pro Forma Options > Suppress Pro Forma processing.
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Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Other Input Changes

General > Basic Data > Miscellaneous Information
Input fields “Qualified timber gain – override” and “X if the corporation made any payments that
would be required it to file Forms 1042 and 1042-S under chapter 3 or 4” have been added.

General > Basic Data > State Information
New fields have been added to enter 50% and 100% bonus depreciation taken in 2015 and Section
179 deduction taken in 2015. These fields are for state use only.

General > Letter and Filing Instructions > Transmittal Letter
Input field “Do not prepare separate letters for certain federal forms” has been added.

General > Letters and Filing Instructions > Miscellaneous Options and Overrides
New section “Federal Filing Address Overrides” is added.

Income/Deductions > Dividends
New columns for payers address have been added.

Foreign > 114/8938 > Form 8938 Part II – Asset and Foreign Stock Information
New column for “GIIN Number” has been added.

Foreign > 114/8938 > 8938 Closely held owner information
New Section “Ownership Information” has been added.

Other > 1139 > Computation of Decrease in Tax
Input field “Exclude carryback” has been added to exclude the net operating loss carryback to a
specific year.

Income/Deductions > Gains and Losses
New column for “Quantity” has been added.

Income/Deductions > Section 179/280 Recapture, 4684 ELF
New section “4684 ELF Information” has been added.

Income/Deductions > Like-Kind Exchange > Supplemental Information 1
Realized and Recognized Gain in Multi-asset Exchange" has been added to the bottom of the form.
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General > Depreciation and Depletion Options – Overrides
Input fields "Code for depreciation reports: Landscape (1), Portrait (2), Small font (3)" and "Section
179 carryover from passthrough entities" have been removed from the "Depreciation Options"
section.

Income/Deductions > Domestic Production Activity Deduction other Information >
Override

Input fields "Total cost of goods sold from all activities - All Activities" and "Total cost of goods
sold from all activities - Oil-Related Activities" have been added.

Income/Deductions > Rent and Royalty > General
Input field "Schedule M-3 Designation Code" has been added.

General > Electronic Filing > General
Section "General Information" has been expanded and separated into eight sections.

Income/Deductions > Business > Other Deductions > Extraterritorial Income Exclusion
from Form 8873 > Detail

Input fields "X to Pro Forma" and "Basis for Entitlement Statement" have been added to the bottom
of the form.

Extensions > Federal Extension
Input field "Print IRS mailing address on federal extension - (Y),(N) #" has been added to the
"Extension Information" section.

Income/Deductions > Farm/4835
Input field "Schedule M-3 Designation Code" has been added.

Other Returns > 1120-H-Homeowners Association > General
Input fields "X to include property acquisitions in expenditures for 90% test" and "Acquisitions of
personal and real property - override" have been added.

Income/Deductions > Fiduciary Passthrough

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added.
Section for "Other Income and Deductions" is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the State columns.

Income/Deductions > Partnership Passthrough

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added.
Section for "Other Income and Deductions" is opened to C Corporation.
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Input field "Apportionable cost of goods sold" has been added to the State columns.

Input field "Comm revit/disaster area ded from RRE act" is opened to C Corporation.

Foreign > Foreign Operations of US Corporations
Input field "Valid statement if the corporation was a specified domestic entity required to file
Form 8938" has been added.

Income/Deductions > Partnership Passthrough or Fiduciary Passthrough

New codes "20 - Enhanced oil recovery credit" and "21 - Increasing research - eligible small
business" have been added to the "Code" field under Credits and credit recapture.
Section for "Other Income/Deductions" is opened to C Corporation.

Credits > 8827 > Credit for Prior Year Minimum Tax
Input fields "Section 383 Minimum Tax Credit Computation" and "Section 384 Minimum Tax Credit
Computation" have been added. Input field "Form 3800, Line 38 Credit Allowed for Current Year"
has been added to Worksheet View Credits > Credits Summary the "General Business, Other &
Patrons’ Credits.

Credits
Input field "Explanation for Current Year Credit Differing from Deduction" has been added to the
"Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits*" section.

Credits > 6765 > Credit for Increasing Research Activities
Input fields added for Eligible small business, Qualified small business electing payroll tax credit,
and Portion of line 36 elected as payroll tax credit.

Credits > 3468 > General
Input field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement" has been added to the
"Form 3468 - Other Information" section.

Credits > 8586 and 8609 > Low Income Housing Credit > Detail
Input fields "Qualified basis of low income building - override" and "X to Pro Forma qualified basis
of low income building" have been added.

Credits > 8941
Input field "X if you filed a tax return for tax year 2014 and also included a Form 8941 with line A
checked "Yes" and line 12 showing a positive amount" has been added.

Taxes > Personal Holding Company Tax > Testing for Exclusions to PHC Income
This new section has been added for tests added to automatically check for exclusions of items
from PHC income.

Taxes > Recapture of Investment Credit

"Cost" in the "Form 4255 - Tax From Recomputing A Prior Year Investment Credit" section has
been changed to "Credit Base - Previous Tax Year".
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Columns for "Net Change in Nonqualified Nonrecourse Financing", "Credit Taken on Form
3800 in Prior Years", "Unused GBC Would Have Been Allowed", and "Unused GBC Would Have
Been Allowed Had There Been No Credit" have been added.
Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.

Common State > Allocation and Apportionment – Total Everywhere Overrides
Input field "X to Pro Forma Total Everywhere Override next year" has been added. Check the field
to pro forma total everywhere override information entered on Worksheet View Common State >
Allocation and Apportionment – Total Everywhere Overrides > Options through Transportation
Factor.

Common State > State/City Common Data > Principal Business Address/Firm Information
Input fields "Province" and "Foreign country" have been added to the "Firm Information or Location
of Books if Diff than Fed - Override" section.

Other > 1128
Input added to prepare Form 1128.

Other Returns > 1120-F

Input field "X if the corporation is claiming treaty benefits pursuant to a Competent Authority
determination" has been added to Worksheet View Other Returns > 1120-F > General.
Input fields "Disallowed passive interest expense - override" and "Deferred passive interest
expense allowed - override" have been added to Worksheet View Other Returns > 1120-F >
Schedule I - Interest Expense Allocation Under Regs. Sec. 1.882-5.
Use input field "Chapter indicator" on Worksheet View Other Returns > 1120-F > Form 1042-S
– Foreign Person’s US Source Income Subject, to indicate whether the amounts were withheld
(or paid by the withholding agent) pursuant to chapter 3 or chapter 4.
Input field "LOB code" has been added to the "Recipient's Information" section on Worksheet
View Other Returns > 1120-F > Form 1042-S – Foreign Person’s US Source Income Subject to.
Input fields "Chapter 3 status code" and "Chapter 4 status code" have been added to the
"Intermediary and Other Information" section.
Use Worksheet View Other Returns > 1120-F > Form 8805 to prepare Copy C of Form 8805
and Worksheet View Other Returns > 1120-F > Form 8288-A to prepare Copy B of Form 8288-
A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

This feature is only available in worksheet view.
2015 consolidated NOL adjustments will not automatically be taken into account when a
consolidated member company’s pro forma is processed in 2016. In the past, each separate
member’s NOL pro formaed input had to be manually adjusted for any prior year
consolidated differences to be properly reflected in the member company’s 2016 NOL
calculation.
To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments"
and "Member Companies' AMT NOL Pro Forma Adjustments" were created. There is a summary
of the application of the Net Operating Loss carryover on the consolidated return. These
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summary grids provide a detailed comparison of each member’s separate company NOL
carryover to the consolidated NOL carryover attributed to it, and show the adjustment, if
any, that needs to be made to member's company 2016 pro forma to reflect any 2015
consolidated NOL adjustments.
They may be exported to an Excel spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you
may elect to have the program use these adjustments to calculate the member’s company
current year NOL deduction. Your original 2016 pro forma’d input will remain unchanged.
Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the
automatic update to be performed. To select this automatic update option, mark the "Adjust
this non-consolidated company’s NOL pro forma based on its prior year consolidated
membership" field on Export > Consolidated Members' NOL Proforma Adjustments > Option to
Adjust Member Companies' Pro Forma. For more information, see help.

Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers
This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income
(Loss) Items workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction
Items workpapers; and Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers.
Workpapers will now cross foot (columns (a) + (b) + (c) = column (d)). Due to laser mask size
constraints only the consolidated amount column was added.

States

We added the ability to e-file state estimate payments for:

Minnesota New York City Tennessee

We added Form 8879-SO, State Signature Form for:

Alaska Nebraska
Connecticut New Jersey
Delaware New Mexico
Florida North Carolina
Idaho North Dakota
Illinois Rhode Island
Kansas Tennessee
Maine Texas
Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

Detroit

District of Columbia

Nebraska

New Hampshire

New York City Combined corporation
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New Consolidated/Combined State Forms
The following forms can now be processed:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

California
We added the following:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)
California Real Estate Withholding Tax Statement (Form 593)

Connecticut
We added the following:

CT-1120A-CU - Apportionment Computation for Combined Unitary Filers
CT-1120CU-MI - Combined Group Member Information
CT-1120CU-MTB - Tax on Combined Group Minimum Tax Base
CT-1120CU-NCB - Nexus Combined Base Tax Calculation
CT-1120CU-NI - Tax on Combined Group Net Income
CT-1120CU - Combined Unitary Corporation Business Tax Return

Michigan - Detroit
We added the following:

Form 5297 - City of Detroit Corporate Income Tax Return
Form 5298 - City of Detroit Corporate Renaissance Zone Schedule
Form 5299 - City Corporate Income Tax E-file Payment Voucher
Form 5300 - City of Detroit Corporate Income Tax Quarterly Voucher
Form 5301 - Application for Extension of Time to File City Corporate Income Tax Return
Form 5324 - City of Detroit Corporate Income Tax Penalty and Interest Computation for
Underpaid Estimated Tax

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (CT-
639-ATT)
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Ohio
We removed the following:

Form CAT-12
Form FIT-10

Oklahoma
We added 504-C, Application for Extension of Time to File.

Rhode Island
We added 2D Barcodes.

Wisconsin
We added Schedule BD, Business Development Credit.
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S Corporation (1120S) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal

Form 1128
Form 1120, Application to Adopt, Change, or Retain a Tax Year, is prepared form input on
Worksheet View Other > 1128 > Part I, General Information through Part III, Ruling Request.

Form 7004
You can select the new option “Print IRS mailing address on federal extension” on Worksheet View
Extensions > Federal Extension > Line 17, to Print IRS mailing address at the bottom of Form 7004.
An Office Manager option is also available.

Form 8830
The Enhanced Oil Recovery Credit form has been added to the program.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Schedule D/Form 8949

Input has been added for “Quantity” of shares.
Schedule M-3. Schedule M-3 designation codes “SL”, “AC” and “SA” have been added for
rental and farm activities.

Schedule M-3, Part II, Lines 1 through 8
We will now produce a supporting statement for each of the lines 1 through 8 on Part II.

Carryover Information Suppression
The General Carryover Data report and the Detail Carryover Schedule will be suppress when the
option to “Suppress Pro Forma Processing” is selected on Worksheet View General > Return Options
> Pro Forma Options > Suppress Pro Forma processing.

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Other Input Changes

General > Basic Data > Miscellaneous Information
Input fields “Qualified timber gain – override” and “X if the corporation made any payments that
would be required it to file Forms 1042 and 1042-S under chapter 3 or 4” have been added.
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General > Basic Data > State Information
New fields have been added to enter 50% and 100% bonus depreciation taken in 2015 and Section
179 deduction taken in 2015. These fields are for state use only.

General > Letter and Filing Instructions > Transmittal Letter
Input field “Do not prepare separate letters for certain federal forms” has been added.

General > Letters and Filing Instructions > Miscellaneous Options and Overrides
New section “Federal Filing Address Overrides” is added.

Income/Deductions > Dividends
New columns for payers address have been added.

Foreign > 114/8938 > Form 8938 Part II – Asset and Foreign Stock Information
New column for “GIIN Number” has been added.

Foreign > 114/8938 > 8938 Closely held owner information
New Section “Ownership Information” has been added.

Other > 1139 > Computation of Decrease in Tax
Input field “Exclude carryback” has been added to exclude the net operating loss carryback to a
specific year.

Income/Deductions > Gains and Losses
New column for “Quantity” has been added.

Income/Deductions > Section 179/280 Recapture, 4684 ELF
New section “4684 ELF Information” has been added.

Income/Deductions > Like-Kind Exchange > Supplemental Information 1
Realized and Recognized Gain in Multi-asset Exchange" has been added to the bottom of the form.

General > Depreciation and Depletion Options – Overrides
Input fields "Code for depreciation reports: Landscape (1), Portrait (2), Small font (3)" and "Section
179 carryover from passthrough entities" have been removed from the "Depreciation Options"
section.

Income/Deductions > Domestic Production Activity Deduction other Information >
Override

Input fields "Total cost of goods sold from all activities - All Activities" and "Total cost of goods
sold from all activities - Oil-Related Activities" have been added.

Income/Deductions > Rent and Royalty > General
Input field "Schedule M-3 Designation Code" has been added.
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General > Electronic Filing > General
Section "General Information" has been expanded and separated into eight sections.

Income/Deductions > Business > Other Deductions > Extraterritorial Income Exclusion
from Form 8873 > Detail

Input fields "X to Pro Forma" and "Basis for Entitlement Statement" have been added to the bottom
of the form.

Extensions > Federal Extension
Input field "Print IRS mailing address on federal extension - (Y),(N) #" has been added to the
"Extension Information" section.

Income/Deductions > Farm/4835
Input field "Schedule M-3 Designation Code" has been added.

Other Returns > 1120-H-Homeowners Association > General
Input fields "X to include property acquisitions in expenditures for 90% test" and "Acquisitions of
personal and real property - override" have been added.

Income/Deductions > Fiduciary Passthrough

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added.
Section for "Other Income and Deductions" is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the State columns.

Income/Deductions > Partnership Passthrough

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added.
Section for "Other Income and Deductions" is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the State columns.

Input field "Comm revit/disaster area ded from RRE act" is opened to C Corporation.

Foreign > Foreign Operations of US Corporations
Input field "Valid statement if the corporation was a specified domestic entity required to file
Form 8938" has been added.

Income/Deductions > Partnership Passthrough or Fiduciary Passthrough

New codes "20 - Enhanced oil recovery credit" and "21 - Increasing research - eligible small
business" have been added to the "Code" field under Credits and credit recapture.
Section for "Other Income/Deductions" is opened to C Corporation.
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Credits > 8827 > Credit for Prior Year Minimum Tax
Input fields "Section 383 Minimum Tax Credit Computation" and "Section 384 Minimum Tax Credit
Computation" have been added. Input field "Form 3800, Line 38 Credit Allowed for Current Year"
has been added to Worksheet View Credits > Credits Summary the "General Business, Other &
Patrons’ Credits.

Credits
Input field "Explanation for Current Year Credit Differing from Deduction" has been added to the
"Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits*" section.

Credits > 6765 > Credit for Increasing Research Activities
Input fields added for Eligible small business, Qualified small business electing payroll tax credit,
and Portion of line 36 elected as payroll tax credit.

Credits > 3468 > General
Input field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement" has been added to the
"Form 3468 - Other Information" section.

Credits > 8586 and 8609 > Low Income Housing Credit > Detail
Input fields "Qualified basis of low income building - override" and "X to Pro Forma qualified basis
of low income building" have been added.

Credits > 8941
Input field "X if you filed a tax return for tax year 2014 and also included a Form 8941 with line A
checked "Yes" and line 12 showing a positive amount" has been added.

Taxes > Personal Holding Company Tax > Testing for Exclusions to PHC Income
This new section has been added for tests added to automatically check for exclusions of items
from PHC income.

Taxes > Recapture of Investment Credit

"Cost" in the "Form 4255 - Tax From Recomputing A Prior Year Investment Credit" section has
been changed to "Credit Base - Previous Tax Year".
Columns for "Net Change in Nonqualified Nonrecourse Financing", "Credit Taken on Form
3800 in Prior Years", "Unused GBC Would Have Been Allowed", and "Unused GBC Would Have
Been Allowed Had There Been No Credit" have been added.
Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.

Common State > Allocation and Apportionment – Total Everywhere Overrides
Input field "X to Pro Forma Total Everywhere Override next year" has been added. Check the field
to pro forma total everywhere override information entered on Worksheet View Common State >
Allocation and Apportionment – Total Everywhere Overrides > Options through Transportation
Factor.
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Common State > State/City Common Data > Principal Business Address/Firm Information
Input fields "Province" and "Foreign country" have been added to the "Firm Information or Location
of Books if Diff than Fed - Override" section.

Other > 1128
Input added to prepare Form 1128.

Other Returns > 1120-F

Input field "X if the corporation is claiming treaty benefits pursuant to a Competent Authority
determination" has been added to Worksheet View Other Returns > 1120-F > General.
Input fields "Disallowed passive interest expense - override" and "Deferred passive interest
expense allowed - override" have been added to Worksheet View Other Returns > 1120-F >
Schedule I - Interest Expense Allocation Under Regs. Sec. 1.882-5.
Use input field "Chapter indicator" on Worksheet View Other Returns > 1120-F > Form 1042-S
– Foreign Person’s US Source Income Subject, to indicate whether the amounts were withheld
(or paid by the withholding agent) pursuant to chapter 3 or chapter 4.
Input field "LOB code" has been added to the "Recipient's Information" section on Worksheet
View Other Returns > 1120-F > Form 1042-S – Foreign Person’s US Source Income Subject to.
Input fields "Chapter 3 status code" and "Chapter 4 status code" have been added to the
"Intermediary and Other Information" section.
Use Worksheet View Other Returns > 1120-F > Form 8805 to prepare Copy C of Form 8805
and Worksheet View Other Returns > 1120-F > Form 8288-A to prepare Copy B of Form 8288-
A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

This feature is only available in worksheet view.
2015 consolidated NOL adjustments will not automatically be taken into account when a
consolidated member company’s pro forma is processed in 2016. In the past, each separate
member’s NOL pro formaed input had to be manually adjusted for any prior year
consolidated differences to be properly reflected in the member company’s 2016 NOL
calculation.
To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments"
and "Member Companies' AMT NOL Pro Forma Adjustments" were created. There is a summary
of the application of the Net Operating Loss carryover on the consolidated return. These
summary grids provide a detailed comparison of each member’s separate company NOL
carryover to the consolidated NOL carryover attributed to it, and show the adjustment, if
any, that needs to be made to member's company 2016 pro forma to reflect any 2015
consolidated NOL adjustments.
They may be exported to an Excel spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you
may elect to have the program use these adjustments to calculate the member’s company
current year NOL deduction. Your original 2016 pro forma’d input will remain unchanged.
Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the
automatic update to be performed. To select this automatic update option, mark the "Adjust
this non-consolidated company’s NOL pro forma based on its prior year consolidated
membership" field on Export > Consolidated Members' NOL Proforma Adjustments > Option to
Adjust Member Companies' Pro Forma. For more information, see help.
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Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers
This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income
(Loss) Items workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction
Items workpapers; and Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers.
Workpapers will now cross foot (columns (a) + (b) + (c) = column (d)). Due to laser mask size
constraints only the consolidated amount column was added.

States

We added the ability to e-file state estimate payments for:

Minnesota New York City Tennessee

We added Form 8879, State Signature Forms for:

Alaska Nebraska
Connecticut New Jersey
Delaware New Mexico
Florida North Carolina
Idaho North Dakota
Illinois Rhode Island
Kansas Tennessee
Maine Texas
Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

Detroit

District of Columbia

Nebraska

New Hampshire

New Consolidated/Combined State Forms
The following forms can now be processed:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

New State Forms
The following forms can now be processed:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)
California Real Estate Withholding Tax Statement (Form 593)

Arkansas
We added additional supporting statements to Arkansas Schedule K-1.
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Georgia
We added Form G-7 NRW, Nonresident Withholding Return (Summer 2016).

Idaho
We added a support statement to Form 41S, Idaho S Corporation Income Tax Return, for other
items.

Maine
We added Form 1099ME, Pass-Through Withholding.

Michigan- Detroit
We added the following:

Form 5297 - City of Detroit Corporate Income Tax Return
Form 5298 - City of Detroit Corporate Renaissance Zone Schedule
Form 5299 - City Corporate Income Tax E-file Payment Voucher
Form 5300 - City of Detroit Corporate Income Tax Quarterly Voucher
Form 5301 - Application for Extension of Time to File City Corporate Income Tax Return
Form 5324 - City of Detroit Corporate Income Tax Penalty and Interest Computation for
Underpaid Estimated Tax

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (CT-
639-ATT)

Ohio
We removed the following:

Form CAT-12
Form FIT-10

Oklahoma
We added 504-C, Application for Extension of Time to File.

Wisconsin
We added the following:

Schedule BD, Business Development Credit
Schedule MT, Alternative Minimum Tax
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Fiduciary (1041) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Miscellaneous

We reorganized Electronic Filing input and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Depreciation Department Number is now four characters (was two)
(1040/1041/1120/1120S/1065).
We added the 8879-SO (state only) for states without a signature form
(1041/1120/1120S/1065).
We added the ability to file Form 8865 from a 1041 return.
We added the ability to randomly generate the ERO PIN for 1041 returns like we do for 1040
returns.

Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages - 2848, 8879, 3520, and 3115 (1041/1120/1120S/1065).
We added "amended" to the form description on the letters for amended returns.
We added “Mail To:” and the mailing address to print at the bottom of extension and
estimates, 7004, 8868. This will not print if the return is selected for electronic filing.
We adjusted all letters and forms for the new Federal (and state) due dates for extended
returns.

Extensions
We moved the “Extensions” section to its own category; this is now the second item on the menu.

Federal Links Worksheet
We added “Autoflow” and "Date Calculated" to the worksheet to be easily used in the DataScans
created.
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Drill Downs
We continue adding drill downs for major forms:

Form 8960, Net Investment Income Tax, Line 19a - Adjusted gross income
Schedule B, Interest and Ordinary Dividends, Line 10, Additional modifications (time
available)

ESBT

We added a QPAI schedule under the ESBT menu (which corrected an issue with the regular
QPAI schedule including ESBT amounts).
We changed the treatment of qualified dividend netting on 4952 to match 1040.

Consistency/Usability Initiative Changes

We added IRS Form names to menu for search ability.
We revised the menu for logic and consistency.
We moved Extension in the menu to second after General.
We added summary grids to State Estimate Payment and State Extension Payment sections.

Organizer
Alphabetize K-1s on Organizers. Default is to alphabetize.

States
Automatic inclusion of nonresident state return for e-file when applicable for resident credit for
taxes paid.

Add e-file

Delaware
Rhode Island
South Carolina
Virginia

Arkansas
We added the following:

AR1000TC, Schedule of Tax Credits
AR4-FID, Interest and Dividend Schedule

Arizona
We added the following:

8879-F, Efile Signature Authorization
Form 141AZ V – Payment Voucher
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California

Amended returns and extensions can now be filed electronically.
We added CA 8453-FID (PMT) – Payment for Automatic Extension and Estimate Payment
Authorization for Fiduciaries.
We added CA 8879(PMT) – Electronic Funds Withdrawal Payment Signature Authorization for
Individuals and Fiduciaries.

Connecticut
We added the following:

CT-1041 Reminder Sheet, Checklist for Filing your Return
CT-1041V Reminder Sheet, Checklist for Filing your Electronic Filing Payment Voucher

District of Columbia
We added electronic filing estimates.

Iowa
We added 1041 Schedule I, Alternative Minimum Tax – Estates and Trusts.

Kansas
We added K-41ES – Estimated Voucher.

Michigan

We now calculate credit for income tax paid to other states entered based on the other state
tax rate.
Also, we added a statement on Form MI 1041 to show the calculation for the credit on Line
14a and Line 14b.

North Dakota
We added electronic filing estimates.

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

Form IT-217, Claim for Farmers’ School Tax Credit
Form IT-135, Sales and Use Tax Report for Purchases of Items and Services
IT-112-R, Resident Credit
IT-225, NYS Modifications
IT-1099R, Summary of Federal Form 1099R Statements
electronic filing estimates

Ohio
We added IT K-1, Beneficiary’s Information.
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Oklahoma
We added the following:

Oklahoma Electronic Filing (Summer 2016)
Electronic filing estimates
504-C, Application for Extension of Time to File
EF-V, Business Filers Income Tax Payment Voucher

Pennsylvania
We added supporting detail for PA RK-1, Line 6, and NRK-1, Line 4.

Texas
We added 05-158-B FINAL, Franchise Tax Report.

Wisconsin
We added the following:

Schedule BD, Business Development Credit
Electronic filing estimates
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Exempt Organization (990) Product Enhancements - Worksheet
View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Gains
Add a column in for ‘Quantity’ right after the ‘Description’ column. This will allow users to import
and export the number of shares from an Excel® file. We will put the number back in the
description field on the tax form.

Federal Links Worksheet
We added "Date Calculated" to the worksheet to be easily used in the DataScans created.

Extended Due Dates

Form 8868 has been revised to allow one 6-month automatic extension.
It will no longer be necessary to request a second 3-month extension.

Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Letters:

We added separate filing instructions and transmittal letters for these items to be
used in future print packages – 114, 2848, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if
that report is included in the return.

We moved “Extensions” from the “Other” category to its own category; this is now the
second item on the menu.

A selection can now be made to print the mailing address at the bottom of extension Form
8868. This information will not be printed if the extension has been selected for electronic
filing.
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Consistency/Usability Initiative Changes

We revised the menu for logic and consistency.
We moved Extension in the menu to second after General.

States

State Reporting of Grants and Contributions
Form 990-PF Return of Private Foundation > Grants and Contributions Paid or Approved for Future
Payment has added state use information fields. These can be used in conjunction with Form 990-
PF Return of Private Foundation > State Use Information for Grants and Contributions Paid to
prepare the grants and contributions statement required for California Form 199. It is no longer
necessary to provide this additional information on the California worksheets.

Minnesota
We added the Charitable Trust Annual Report.
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Estate and Gift (706/709) Product Enhancements - Worksheet View
Return to Table of Contents.

Federal
Added new options to prepare Form 8971, Information Regarding Beneficiaries Acquiring Property
From a Decedent.

Overrides are available for the asset description for Form 8971 purposes.
Overrides are available for the percent/amount of an asset that carries to Form 8971.

Tax Product Enhancements 2016.01000 - Worksheet View • 40



Employee Benefit Plan (5500) Product Enhancements - Worksheet
View
Return to Table of Contents.

There are no updates available with this release.
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Tax Product Enhancements 2016.01000 - Interview View

Individual (1040) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

IRS Fraud Prevention
An ID type field is now available to indicate driver’s license or state issued ID.

Federal Links Worksheet
We added “Autoflow” and "Date Calculated" to the worksheet to be easily used in the DataScans
created (Summer 2016).

Amortization Report
We added a new amortization report for 1040 (already available for business systems).

Wages Statement
The wages statement now includes a statement reference number on Form 1040, Line 7.
Previously, no statement reference printed (Summer 2016).

Expatriate Wages
We added fields for state information.

Gains

We added a column for "Quantity" after the "Description" column. This allows you to import
and export the number of shares from a Microsoft® Excel® file. We will put the number back
in the description field on the tax form.
We added fields for state ID numbers.

Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
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Depreciation Department Number is now four characters (was two).

Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages – 114, 2848, 8879, 3520, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.

New Drill Downs
We added drill downs for:

Page 1 Line 10, Taxable refunds, credits, or offsets of state and local income taxes
Page 1 Line 21, Other Income - as this line can have items that come from many different
entries
Page 1 Line 44, Tax
Form 6251, Line 27, Other adjustments, including income-based related adjustments

1040NR, U.S. Nonresident Alien Income Tax Return

We added e-file (which entails input and output changes to Form 1040NR, Form 8840, and
Form 8843).
We added a check box that when checked will add the text “Not present in U.S. -No U.S.
immigration status” to Page 5, Line E, Immigration Status. Per the IRS, this is the required
text if the taxpayer was not present in the United States on the last day of the tax year, and
has no U.S. immigration status.

New Forms

Form 8854, Initial and Annual Expatriation Statement.
We will add with limited calculations only.

Includes electronic filing.

Form 8830, Enhanced Oil Recovery Credit
Form 8974, Qualified Small Business Payroll Tax Credit for Increasing Research Activities

Supporting Statement
We now provide a statement for Line 65, 20xx estimated tax payments and amount applied form
20xx return (prior year return) (1040 and 1040NR).

Revised Footer
When there is a statement for interest and penalties, text will print at the bottom of Form 1040,
Page 2. It will indicate the total amount due, including interest and penalties.

Revised Forms

Form 8867. Paid Preparer's Earned Income Credit Checklist is revised and renamed. The
changes are a result of the expansion of paid preparer's due diligence requirements to cover
the Child Tax Credit, the American Opportunity Education Credit, and the Earned Income
Credit.
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Form 8958. Allocation of Tax Amounts Between Certain Individuals in Community Property
States allows you to report every W-2 source AND split each.
Form 8965. Input from the IRS 1095-A will be used in the calculations determining total
months of coverage for the tax household.
1099-MISC Summary Grid. We added all possible additional income fields to the Summary
Grid for the 1099-MISC. Example – rents, royalties, and nonemployee compensation.
Pro forma. We added the "Delete from pro forma option" for Forms 1098 Mortgage Interest
Statement and Forms 1099.
PTP. Allows for aggregation of PTP K-1s, which will offset gains and losses from different
entities in one PTP.
Passthroughs. We added fields for Section 59(e)(2) expenditure carryovers.
Investment management fees. The description now appears as “Payer Name – Investment
Expenses” when an amount is entered in the investment expenses field on 1099-INT, 1099-
DIV and Consolidated 1099 input.

Schedule B

Three fields are available for tax-exempt interest. The field on the IRS 1099-INT is used for
the federal return and two other fields are available for tax exempt interest that is state
nontaxable and state taxable. When an entry is made in one of the state fields, the other
field is auto-filled with the difference between the federal and state amount.
The IRS 1099-DIV uses the same approach.
In response to a change by the IRS, a field is added for bond premium on Treasury
obligations. As a result, amounts of bond premium are no longer allocated to interest from
Treasury obligations.

Form 8621, Information Return by a Shareholder of a Passive Foreign Investment
Company or Qualified Electing Fund

We added the following:

The option to code 8621 income as dual status so that it will flow to the 1040 statement.
Additional detail input for prior year amounts on Form 8621.
A grid to 8621 - Return by a Shareholder of a PFIC or QEF > Distributions/Dispositions from
Section 1291 Fund to allow import and export of data.

Diagnostic
We added a diagnostic for an automatic sale when business use % is entered. This will alert you
that the cost basis will flow to Form 4797 at 100%, as opposed to some business use %. When the
matching sale number is used and "percent to be excluded" is entered for depreciation, the percent
is not applied to the "cost or other basis" of the asset.

Tax Equalization
We added the following:

An override for US hypo wages: Foreign > Expatriate Wages > - US hypothetical Comp -
override
Overrides for all Form 8959 lines
Pennsylvania cities
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IRS Processing Notes

Form 8812. Returns may be filed and will be processed by the IRS when the filing season
opens, but refunds containing earned income credit (EIC) or additional child tax credit
(ACTC) will not be issued until February 15, 2017.
Form 8885. The health coverage tax credit (HCTC) can no longer be taken for health plans
offered through a Health Insurance Marketplace. Monthly advance payments of the HCTC
have been implemented on a limited interim basis. The IRS expects to fully implement the
program in January 2017.
Form 8941. The credit for small employer health insurance premiums may only be claimed
over two consecutive years. If the credit was claimed in 2014, it cannot be claimed for
2016.

Organizer
Alphabetize K-1s on Organizers. Default is to alphabetize.

States

We added automatic Foreign Tax Credit calc to applicable states.
Allow only for Canadian Province: MA, MI, MN, NY, VT

Allow for foreign countries: AL, AZ, IA, IN, KS, MT, NC, NM, VA

Allow to state, territory of US possession: CO, DC, ID, IL, MD, MS, ND, OR, UT

We standardized automatic inclusion of nonresident state return for e-file when applicable
for resident credit for taxes paid.
We added the ability to e-file state estimate payments for:

DC, NY, NYC, TN FAE-172

Deleting a state from a return will retain the state taxes paid for Pro Forma purposes, making
them available for next year’s Schedule A deduction.

Alabama
We added AL COA - Change of Address Form.

Arizona
We added AZ 352, Credit for Contributions to Qualifying Foster Care Charitable Organizations.
Input is on Arizona, Credits > Contributions to Qualifying Foster Care Charitable Organizations.

Arkansas
We added the following:

AR EST PMT, Estimated Tax Payment Bank Authorization for Direct Debit
AR EXT PMT, Extension Payment Bank Authorization for Direct Debit
AR TAX PMT, Income Tax Payment Authorization for Direct Debit

California
We added the following:

CA 8453(PMT) – Payment for Automatic Extension and Estimate Payment Authorization for
Individuals
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CA 8879(PMT) – Electronic Funds Withdrawal Payment Signature Authorization for Individuals
and Fiduciaries
CA LLC-12NC, Statement of No Change
Direct debit of extension payments
2D barcode (540NR)

Colorado

We added the following:
104AD, Subtractions from Income

104CH, Voluntary Contributions Schedule

104US, Consumer Use Tax Reporting Schedule

2D barcodes are now mandated.

Connecticut
We now flow the Property Tax from federal for Property Tax Credit purposes.

District of Columbia
We added D-40WH, Withholding Tax Schedule.

Georgia

We added the following:
CR-207, Rural Physicians Credit

CR-208, Adoption of a Foster Child Credit

CR-209, Eligible Single-Family Residence Tax Credit

Supplemental W-2, Income Statement Details

2D barcode (500 and 500X) are now mandated.

Hawaii
We added N-311, Refundable Food/Excise Tax Credit.

Indiana
We added Schedule IN K-1, Shareholder’s/Partner’s Share of AGI, Deductions, Modifications and
Credits.

Iowa
We added the following:

100A, Capital Gain Deduction – Livestock
100B, Capital Gain Deduction – Real Property, Farm
100C, Capital Gain Deduction – Real Property, NonFarm
100D, Capital Gain Deduction – Timber
100E, Capital Gain Deduction – Business
100F, Capital Gain Deduction – ESOP
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Maryland
We added the following:

548, Power of Attorney. Input is on Federal Form S-2
502R, Retirement Income

Massachusetts

Returns may allow PDF attachments.
We added M-8379, Nondebtor Spouse Claim and Allocation for Refund Due.
We added Sch OJC, Income Tax Paid to Other Jurisdictions.

Michigan
We added 5472, Direct Debit of Individual Income Tax Payment.

Michigan – DTW
We added the following:

Part-Year Resident Income Tax Return
CF 1040X, Amended Individual Tax Return
CF 1040XPV, Amended Income Tax Return Payment Voucher

Minnesota
We added the following:

A statement on the MN return that shows how the pass through income is calculated when
there are suspended losses.
M1REF, Refundable Credits.
M1PSC, Credit for Parents of Stillborn Children.

Mississippi
We added 80-360, Catastrophe Savings Tax.

Missouri - Missouri Kansas City
We added the following:

RD-108, Payment Voucher
RD-109, Payment Voucher
Electronic Filing of Form 108 and 109

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added IT-639-ATT, Eligible Employee Information for the Minimum Reimbursement Credit.

New York City
We added ability to generate multiple Declaration of Estimated Tax (vouchers 2,3, and 4).
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Ohio

We added IT/SD 2210-100 ANN INC, Annualized Income Worksheet.
We added Separate School District Return Summaries.
We separated School District Letters/Filing Instructions.

Oregon
We added the following:

40-EXT, Extension of Time to File and Voucher
Schedule OR-ADD-DEP, Additional Dependents
Diagnostic alerting to possibility of using OR-PTE
Calculation of Special Medical Subtraction from FD numbers
Automatic carryforwards of prior year credits

Oregon – MUL
We added electronic filing.

Pennsylvania

We removed RCT-101 forms.
We added PA-40 Sch P, Refund Donations to 529 College Savings Program Accounts.

Pennsylvania – Pennsylvania Cities
We added TEQ.

Pennsylvania – Philadelphia

We added electronic filing for Form S1.
We pulled Expat wages to Form AR/WTR.
We added TEQ.

Tennessee
We added the following:

RV-F1307901 (Certification), Franchise and Excise Tax Exemption
FAE 172 and EF
2D barcode

Texas
We added 05-158-B FINAL, Franchise Tax Report.

Vermont
We added EF extensions.
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Wisconsin
We added the following:

Schedule BD, Business Development Credit
Schedule QI, Sale of Investment in a Qualified WI Business
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Partnership (1065) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Federal Links Worksheet
We added "Date Calculated" to the worksheet to be easily used in the DataScans created.

Schedule K-1

We added the option to suppress Schedule K-1 on a Partner by Partner basis.
We added ratio ID Numbers to Passthrough Input for Allocations.
We added an option to Prepare Simplified Increase/Decrease Reconciliation Statement for
Schedule K-1, Item L.
We added an open line item input for Line 13R, Pensions and IRAs.

Apportionment
We added a Zero Apportionment option for state and city returns.

Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Depreciation Department Number is now four characters (was two).

Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages – 114, 2848, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.

Extensions

We moved “Extensions” from the “Other” category to its own category; this is now the
second item on the menu.
The mailing address now prints at the bottom of federal extensions.
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Consistency/Usability Initiative Changes

We revised the menu for logic and consistency.
State Composite and State Adjustments categories in menus are now collapsible.

New Forms
We added the following:

8830, Enhanced Oil Recovery Credit
1128, Application to Adopt, Change or Retain a Tax Year

States

We added the ability to e-file state estimate payments for:

Minnesota Tennessee

We added Form 8879-SO, State Signature Forms for:

Connecticut New Jersey
Delaware New Mexico
Idaho North Dakota
Illinois Rhode Island
Kansas South Carolina
Maine Tennessee
Michigan Texas
Minnesota Utah
Missouri West Virginia
Nebraska Wisconsin
New Hampshire

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

District of Columbia

Nebraska

North Carolina

Oregon Tri-Met and LTD

South Carolina

Arkansas
We added additional supporting statements to Arkansas Schedule K-1.

California
We added the following:

California Form 593, Real Estate Withholding Tax Statement
California Form 588, Nonresident Withholding Waiver Requests

Georgia
We added Form G-7 NRW, Nonresident Withholding Return (added Summer 2016).
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Illinois
We added Crossover functionality Unitary Partnership returns (added Summer 2016).

Maine
We added Form 1099ME, Pass-Through Withholding.

New York
We added the following:

IT-241 - Claim for Clean Heating Fuel Credit
IT-242 - Credit for Conservation Easement Tax Credit
IT-634 - Empire State Jobs Retention Program Credit
IT-641 - Manufacturer's Real Property Tax Credit
IT-635 - Urban Youth Jobs Program Tax Credit
IT-646 - Employee Training Incentive Program Tax Credit
IT-636 - Beer Production Credit
IT-642 - Empire State Musical and Theatrical Production Credit
IT-603 - Claim for EZ Investment Tax Credit and EZ Employment Incentive Credit

Oklahoma
We added Form 504-C (EXT) - Application for Extension of Time to File Income Tax Return.

Nevada
We added the Nevada Commerce Tax (Summer 2016).

Ohio

We removed Form CAT-12.
We added 2D barcodes.

Pennsylvania
We removed RCT-101 forms.

Rhode Island
We added 2D Barcodes.

Wisconsin

We changed Form 3 and Form 3K-1 back to portrait format.
We added Schedule BD, Business Development Credit.
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Corporation (1120) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Forms 1120 Series Filing Due Date Changes

The Federal government has changed the return due dates and extended filing dates.
Effective for tax years beginning after December 31, 2015 C corporations must file by April
15 following the close of the calendar year or the 15th day of the 4th month following the
close of the fiscal year. A C corporation with a June 30 year end must file by September 15.
The extended due date is September 15 for a calendar year; April 15 for a fiscal year ending
on June 30; and the 15th day of the 10th month for all other fiscal years.
The new due dates apply to forms 1120, 1120-F, 1120-RIC, 1120-REIT, 1120-POL, 1120-SF
and 1120-H.

Late Filing Penalty Changes
The minimum late filing penalties for federal returns filed more than 60 days late have been
increased. The penalty the great of (a) $205 or (b) 100% of the tax due. This provision applies to
returns filed after 12/31/2015.

Form 1120, Page 4, Schedule K
Line 19 “During the corporation’s tax year, did the corporation make any payments that would
require it to file Forms 1042 and 1042-S under chapter 3 or chapter 4 of the Code” has been added
to Schedule K. The same question is added to Form 1120-F, page 2, Additional Information, Item
BB.

Form 1120-F

Form 1120-F is now an 8 page form. Page 1, items H through M have been moved to page 2.
Item W(2): Is the corporation claiming treaty benefits pursuant to a Competent Authority
determination” has been added to page 2.
Page 2, Section I has been moved to page 3, pages 4 through 7 become pages 5 through 8.

Form 1120-F, Schedule I
Use Interview Form FC-8, boxes 32 and 63 to override the disallowed passive interest expense and
deferred passive interest expense allowed from Form 8810 reported on Schedule I (Form 1120-F),
lines 24a and 24b respectively.

Form 8288-A and Form 8805
These two forms are added to Form 1120-F only and for e-filing requirements. In prior years the
IRS allowed both forms as a PDF attachment, both forms are now required in XML format.

Form 1120-RIC
New lines 5 through 8 have been added to page 2, part II to compute the alternative timber gain
tax. Part II now reports qualified timber gain on line 4.

Tax Product Enhancements 2016.01000 - Interview View • 53



Form 1128
Form 1128, Application to Adopt, Change, or Retain a Tax Year, is prepared from input on
interview forms TY-1 through TY-7.

Form 3800
Line 1zz on page 3 is used to report the enhanced oil recovery credit (Form 8830). Line 4i on page
3 has been activated for increasing research activities credit (Form 6765).

Form 7004
You can select the new option “Print IRS mailing address on federal extension” on form EXT-1, box
52 to print IRS filling address at the bottom of Form 7004. An Office Manager option is also
available.

Form 8830

The Enhanced Oil Recovery Credit form has been added to the program.
Schedule D, Part IV, has been added to page 2 devoted solely to timber gain tax. The
qualified timber gain is calculated from detail entries on Form D-1 with property code
“CAP”, “1231”, “1245”, or “1250” and Schedule D code of “20.” Use form 4, box 75 to
override.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Schedule D/Form 8949

Input has been added for “Quantity” of shares.
Schedule M-3. Schedule M-3 designation codes “SL”, “AC” and “SA” have been added for
rental and farm activities.

Schedule M-3, Part II, Lines 1 through 8
We will now produce a supporting statement for each of the lines 1 through 8 on Part II.

Passthroughs
Passthrough open line input for Other Income and Deductions on Form O-6, IRS K1F and IRSK1P is
now available for C Corps

Carryover Information Suppression
The General Carryover Data report and the Detail Carryover Schedule will be suppress when the
option to “Suppress Pro Forma Processing” is selected on Interview Form 2, Box 100.

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.
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Other Input Changes

Interview Form 4
Input fields “Qualified timber gain – override” and “X if the corporation made any payments that
would require it to file Forms 1042 and 1042-S under chapter 3 or 4” have been added.

Interview Form 5
New fields have been added to enter 50% and 100% bonus depreciation taken in 2015 and Section
179 deduction taken in 2015. These fields are for state use only.

Interview Form 7
Input field “Do not prepare separate letters for certain federal forms” has been added.

Interview Form 9A
New section “Federal Filing Address Overrides” is added.

Interview Form B-2
New columns for payers address have been added.

Interview Form BNK-2
New column for “GIIN Number” has been added.

Interview Form BNK-2A and BKN-3
New Section “Ownership Information (Form 8938 only)” has been added.

Interview Form CB-3
Input field “Exclude carryback” has been added to exclude the net operating loss carryback to a
specific year.

Interview Form D-1
New column for “Quantity” has been added.

Interview Form D-1A
New section “4684 ELF Information” has been added.

Interview Form D-6
Realized and Recognized Gain in Multi-asset Exchange" has been added to the bottom of the form.

Interview Form DP-9
Input fields "Code for depreciation reports: Landscape (1), Portrait (2), Small font (3)" and "Section
179 carryover from passthrough entities" have been removed from the "Depreciation Options"
section.
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Interview Form DPAD-2
Input fields "Total cost of goods sold from all activities - All Activities" and "Total cost of goods
sold from all activities - Oil-Related Activities" have been added.

Interview Form E-1
Input field "Schedule M-3 Designation Code" has been added.

Interview Forms EF-1 Through EF-3

Section "General Information" has been expanded and separated into eight sections on
Interview Form EF-1.
Sections "Electronic Signatures" and "Electronic Filing Notification - Overrides" have been
moved from Interview Form EF-1 to Interview Form EF-2.
Section "Explanations, Elections and Preparer Notes" has been moved from Interview Form
EF-2 to new Form EF-3.

Interview Form ET-1
Input fields "X to Pro Forma" and "Basis for Entitlement Statement" have been added to the bottom
of the form.

Interview Form EXT-1
Input field "Print IRS mailing address on federal extension - (Y),(N) #" has been added to the
"Extension Information" section.

Interview Form F-1
Input field "Schedule M-3 Designation Code" has been added.

Interview Form H-1
Input fields "X to include property acquisitions in expenditures for 90% test" and "Acquisitions of
personal and real property - override" have been added.

Interview Form IRS K1F

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added to the "Schedule K-1 DPAD, Additional K-1
Info., Schedule M-3, and Other Income and Ded." page.
Section for "Other Income and Deductions" on the "Schedule K-1 DPAD, Additional K-1 Info.,
Schedule M-3, and Other Income and Ded." page is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the "Schedule K-1 Multi-State
Information (Continued)" page.

Interview Form IRS K1P

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added to the "Schedule K-1 Other Information, DPAD,
and Additional K-1 Information" page.
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Section for "Other Income and Deductions" on the "Schedule K-1 Additional Information
Cont'd, Schedule M-3, and Other Income and Deductions" page is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the "Schedule K-1 Multi-State
Information (Continued)" page.

Interview Form N-1
Input field "X if the corporation was a specified domestic entity required to file Form 8938" has
been added.

Interview Form O-1
Input field "Class code" has been added.

Interview Form O-1S
Input field "Comm revit/disaster area ded from RRE act" is opened to C Corporation.

Interview Form O-3
New codes "20 - Enhanced oil recovery credit" and "21 - Increasing research - eligible small
business" have been added to the "Code" field.

Interview Form O-6
Section for "Other Income/Deductions" is opened to C Corporation.

Interview Form P-1A
Input fields "Section 383 Minimum Tax Credit Computation" and "Section 384 Minimum Tax Credit
Computation" have been added to the "Minimum Tax Credit" section, and field "Form 3800, Line 38
Credit Allowed for Current Year" has been added to the "General Business Credit - Other
Information" section.

Interview Form P-2
Input field "Form 5884 - Explanation for Current Year Credit Differing from Deduction" has been
added to the "Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits*" section.

Interview Form P-2A
This new form is used to enter additional information for Form 6765, Credit for Increasing
Research Activities.

Interview Form P-3
Input field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement" has been added to the
"Form 3468 - Other Information" section.

Interview Form P-6
Input fields "Qualified basis of low income building - override" and "X to Pro Forma qualified basis
of low income building" have been added to the "Schedule A (Form 8609)" section.
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Interview Form P-15
Input field "X if you filed a tax return for tax year 2014 and also included a Form 8941 with line A
checked "Yes" and line 12 showing a positive amount" has been added to the "Other Information"
section.

Interview Form PH-3
This new form has been added for tests added to automatically check for exclusions of items from
PHC income.

Interview Form T-7

Column for "Cost" in the "Form 4255 - Tax From Recomputing A Prior Year Investment Credit"
section has been changed to "Credit Base - Previous Tax Year".
Columns for "Net Change in Nonqualified Nonrecourse Financing", "Credit Taken on Form
3800 in Prior Years", "Unused GBC Would Have Been Allowed", and "Unused GBC Would Have
Been Allowed Had There Been No Credit" have been added.
Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.
Now this form is for Form 4255 only. Section for "Form 8611 - Recapture of Low-Income
Housing Credit" has been removed.

Interview Form T-7A
Section "Form 8611 - Recapture of Low-Income Housing Credit" has been moved from Interview
Form T-7 to this new form.

Interview Form MST-T
Input field "X to Pro Forma Total Everywhere Override next year" has been added. Check the field
to pro forma total everywhere override information entered on Interview Forms MST-T/T1 through
MST-TE.

Interview Form GEN-2
Input fields "Province" and "Foreign country" have been added to the "Firm Information or Location
of Books if Diff than Fed - Override" section.

Interview Forms TY Series
Use Interview Forms TY-1 through TY-7 to prepare Form 1128.

Interview Forms FC Series

Input field "X if the corporation is claiming treaty benefits pursuant to a Competent Authority
determination" has been added to Interview Form FC-1.
Input fields "Disallowed passive interest expense - override" and "Deferred passive interest
expense allowed - override" have been added to Interview Form FC-8.
Use input field "Chapter indicator" on Interview Form FC-14 to indicate whether the amounts
were withheld (or paid by the withholding agent) pursuant to chapter 3 or chapter 4.
Input field "LOB code" has been added to the "Recipient's Information" section on Interview
Form FC-14. Input fields "Chapter 3 status code" and "Chapter 4 status code" have been added
to the "Intermediary and Other Information" section.
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Use Interview Form FC-15 to prepare Copy C of Form 8805 and Interview Form FC-16 to
prepare Copy B of Form 8288-A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

This feature is only available in worksheet view.
2015 consolidated NOL adjustments will not automatically be taken into account when a
consolidated member company’s pro forma is processed in 2016. In the past, each separate
member’s NOL pro formaed input had to be manually adjusted for any prior year
consolidated differences to be properly reflected in the member company’s 2016 NOL
calculation.
To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments"
and "Member Companies' AMT NOL Pro Forma Adjustments" were created. There is a summary
of the application of the Net Operating Loss carryover on the consolidated return. These
summary grids provide a detailed comparison of each member’s separate company NOL
carryover to the consolidated NOL carryover attributed to it, and show the adjustment, if
any, that needs to be made to member's company 2016 pro forma to reflect any 2015
consolidated NOL adjustments.
They may be exported to an Excel spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you
may elect to have the program use these adjustments to calculate the member’s company
current year NOL deduction. Your original 2016 pro forma’d input will remain unchanged.
Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the
automatic update to be performed. To select this automatic update option, mark the "Adjust
this non-consolidated company’s NOL pro forma based on its prior year consolidated
membership" field on Export > Consolidated Members' NOL Proforma Adjustments > Option to
Adjust Member Companies' Pro Forma. For more information, see help.

Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers
This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income
(Loss) Items workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction
Items workpapers; and Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers.
Workpapers will now cross foot (columns (a) + (b) + (c) = column (d)). Due to laser mask size
constraints only the consolidated amount column was added.

States

We added the ability to e-file state estimate payments for:

Minnesota New York City Tennessee

We added Form 8879-SO, State Signature Forms for:

Alaska Nebraska
Connecticut New Jersey
Delaware New Mexico
Florida North Carolina
Idaho North Dakota
Illinois Rhode Island
Kansas Tennessee
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Maine Texas
Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

Detroit

District of Columbia

Nebraska

New Hampshire

New York City Combined corporation

New Consolidated/Combined State Forms
The following forms can now be processed:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

New State Forms

California
The following forms can now be processed:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)
California Real Estate Withholding Tax Statement (Form 593)

Connecticut
We added the following:

CT-1120A-CU - Apportionment Computation for Combined Unitary Filers
CT-1120CU-MI - Combined Group Member Information
CT-1120CU-MTB - Tax on Combined Group Minimum Tax Base
CT-1120CU-NCB - Nexus Combined Base Tax Calculation
CT-1120CU-NI - Tax on Combined Group Net Income
CT-1120CU - Combined Unitary Corporation Business Tax Return

Michigan - Detroit
We added the following:

Form 5297 - City of Detroit Corporate Income Tax Return
Form 5298 - City of Detroit Corporate Renaissance Zone Schedule
Form 5299 - City Corporate Income Tax E-file Payment Voucher
Form 5300 - City of Detroit Corporate Income Tax Quarterly Voucher
Form 5301 - Application for Extension of Time to File City Corporate Income Tax Return
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Form 5324 - City of Detroit Corporate Income Tax Penalty and Interest Computation for
Underpaid Estimated Tax

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (CT-
639-ATT)

Ohio
We removed the following:

Form CAT-12
Form FIT-10

Oklahoma
We added 504-C, Application for Extension of Time to File.

Rhode Island
We added 2D Barcodes.

Wisconsin
We added Schedule BD, Business Development Credit.
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S Corporation (1120S) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Form 1128
Form 1128, Application to Adopt, Change, or Retain a Tax Year, is prepared from input on
interview forms TY-1 through TY-7.

Form 7004
You can select the new option “Print IRS mailing address on federal extension” on form EXT-1, box
52 to print IRS filling address at the bottom of Form 7004. An Office Manager option is also
available.

Form 8830

The Enhanced Oil Recovery Credit form has been added back to the program.
Schedule D, Part IV (C Corp only). Part IV has been added to page 2 devoted solely to timber
gain tax. The qualified timber gain is calculated from detail entries on Form D-1 with
property code “CAP”, “1231”, “1245”, or “1250” and Schedule D code of “20.” Use form 4,
box 75 to override.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Schedule D/Form 8949

Input has been added for “Quantity” of shares.
Schedule M-3. Schedule M-3 designation codes “SL”, “AC” and “SA” have been added for
rental and farm activities.

Schedule M-3, Part II, Lines 1 through 8
We will now produce a supporting statement for each of the lines 1 through 8 on Part II.

Carryover Information Suppression
The General Carryover Data report and the Detail Carryover Schedule will be suppress when the
option to “Suppress Pro Forma Processing” is selected on Interview Form 2, box 100.

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.
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Other Input Changes

Interview Form 4
Input fields “Qualified timber gain – override” and “X if the corporation made any payments that
would require it to file Forms 1042 and 1042-S under chapter 3 or 4” have been added.

Interview Form 5
New fields have been added to enter 50% and 100% bonus depreciation taken in 2015 and Section
179 deduction taken in 2015. These fields are for state use only.

Interview Form 7
Input field “Do not prepare separate letters for certain federal forms” has been added.

Interview Form 9A
New section “Federal Filing Address Overrides” is added.

Interview Form B-2
New columns for payers address have been added.

Interview Form BNK-2
New column for “GIIN Number” has been added.

Interview Form BNK-2A and BKN-3
New Section “Ownership Information (Form 8938 only)” has been added.

Interview Form CB-3
Input field “Exclude carryback” has been added to exclude the net operating loss carryback to a
specific year.

Interview Form D-1
New column for “Quantity” has been added.

Interview Form D-1A
New section “4684 ELF Information” has been added.

Interview Form D-6
Realized and Recognized Gain in Multi-asset Exchange" has been added to the bottom of the form.

Interview Form DP-9
Input fields "Code for depreciation reports: Landscape (1), Portrait (2), Small font (3)" and "Section
179 carryover from passthrough entities" have been removed from the "Depreciation Options"
section.
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Interview Form DPAD-2
Input fields "Total cost of goods sold from all activities - All Activities" and "Total cost of goods
sold from all activities - Oil-Related Activities" have been added.

Interview Form E-1
Input field "Schedule M-3 Designation Code" has been added.

Interview Forms EF-1 Through EF-3

Section "General Information" has been expanded and separated into eight sections on
Interview Form EF-1.
Sections "Electronic Signatures" and "Electronic Filing Notification - Overrides" have been
moved from Interview Form EF-1 to Interview Form EF-2.
Section "Explanations, Elections and Preparer Notes" has been moved from Interview Form
EF-2 to new Form EF-3.

Interview Form ET-1
Input fields "X to Pro Forma" and "Basis for Entitlement Statement" have been added to the bottom
of the form.

Interview Form EXT-1
Input field "Print IRS mailing address on federal extension - (Y),(N) #" has been added to the
"Extension Information" section.

Interview Form F-1
Input field "Schedule M-3 Designation Code" has been added.

Interview Form H-1
Input fields "X to include property acquisitions in expenditures for 90% test" and "Acquisitions of
personal and real property - override" have been added.

Interview Form IRS K1F

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added to the "Schedule K-1 DPAD, Additional K-1
Info., Schedule M-3, and Other Income and Ded." page.
Section for "Other Income and Deductions" on the "Schedule K-1 DPAD, Additional K-1 Info.,
Schedule M-3, and Other Income and Ded." page is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the "Schedule K-1 Multi-State
Information (Continued)" page.

Interview Form IRS K1P

Input field "Class code" has been added to the "Schedule K-1" page.
Input fields "Apportionable cost of goods sold - Oil-Related Activities" and "Apportionable cost
of goods sold - All Activities" have been added to the "Schedule K-1 Other Information, DPAD,
and Additional K-1 Information" page.
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Section for "Other Income and Deductions" on the "Schedule K-1 Additional Information
Cont'd, Schedule M-3, and Other Income and Deductions" page is opened to C Corporation.
Input field "Apportionable cost of goods sold" has been added to the "Schedule K-1 Multi-State
Information (Continued)" page.

Interview Form N-1
Input field "X if the corporation was a specified domestic entity required to file Form 8938" has
been added.

Interview Form O-1
Input field "Class code" has been added.

Interview Form O-1S
Input field "Comm revit/disaster area ded from RRE act" is opened to C Corporation.

Interview Form O-3
New codes "20 - Enhanced oil recovery credit" and "21 - Increasing research - eligible small
business" have been added to the "Code" field.

Interview Form O-6
Section for "Other Income/Deductions" is opened to C Corporation.

Interview Form P-1A
Input fields "Section 383 Minimum Tax Credit Computation" and "Section 384 Minimum Tax Credit
Computation" have been added to the "Minimum Tax Credit" section, and field "Form 3800, Line 38
Credit Allowed for Current Year" has been added to the "General Business Credit - Other
Information" section.

Interview Form P-2
Input field "Form 5884 - Explanation for Current Year Credit Differing from Deduction" has been
added to the "Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits*" section.

Interview Form P-2A
This new form is used to enter additional information for Form 6765, Credit for Increasing
Research Activities.

Interview Form P-3
Input field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement" has been added to the
"Form 3468 - Other Information" section.

Interview Form P-6
Input fields "Qualified basis of low income building - override" and "X to Pro Forma qualified basis
of low income building" have been added to the "Schedule A (Form 8609)" section.
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Interview Form P-15
Input field "X if you filed a tax return for tax year 2014 and also included a Form 8941 with line A
checked "Yes" and line 12 showing a positive amount" has been added to the "Other Information"
section.

Interview Form PH-3
This new form has been added for tests added to automatically check for exclusions of items from
PHC income.

Interview Form T-7

Column for "Cost" in the "Form 4255 - Tax From Recomputing A Prior Year Investment Credit"
section has been changed to "Credit Base - Previous Tax Year".
Columns for "Net Change in Nonqualified Nonrecourse Financing", "Credit Taken on Form
3800 in Prior Years", "Unused GBC Would Have Been Allowed", and "Unused GBC Would Have
Been Allowed Had There Been No Credit" have been added.
Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.
Now this form is for Form 4255 only. Section for "Form 8611 - Recapture of Low-Income
Housing Credit" has been removed.

Interview Form T-7A
Section "Form 8611 - Recapture of Low-Income Housing Credit" has been moved from Interview
Form T-7 to this new form.

Interview Form MST-T
Input field "X to Pro Forma Total Everywhere Override next year" has been added. Check the field
to pro forma total everywhere override information entered on Interview Forms MST-T/T1 through
MST-TE.

Interview Form GEN-2
Input fields "Province" and "Foreign country" have been added to the "Firm Information or Location
of Books if Diff than Fed - Override" section.

Interview Forms TY Series
Use Interview Forms TY-1 through TY-7 to prepare Form 1128.

Interview Forms FC Series

Input field "X if the corporation is claiming treaty benefits pursuant to a Competent Authority
determination" has been added to Interview Form FC-1.
Input fields "Disallowed passive interest expense - override" and "Deferred passive interest
expense allowed - override" have been added to Interview Form FC-8.
Use input field "Chapter indicator" on Interview Form FC-14 to indicate whether the amounts
were withheld (or paid by the withholding agent) pursuant to chapter 3 or chapter 4.
Input field "LOB code" has been added to the "Recipient's Information" section on Interview
Form FC-14. Input fields "Chapter 3 status code" and "Chapter 4 status code" have been added
to the "Intermediary and Other Information" section.
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Use Interview Form FC-15 to prepare Copy C of Form 8805 and Interview Form FC-16 to
prepare Copy B of Form 8288-A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

This feature is only available in worksheet view.
2015 consolidated NOL adjustments will not automatically be taken into account when a
consolidated member company’s pro forma is processed in 2016. In the past, each separate
member’s NOL pro formaed input had to be manually adjusted for any prior year
consolidated differences to be properly reflected in the member company’s 2016 NOL
calculation.
To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments"
and "Member Companies' AMT NOL Pro Forma Adjustments" were created. There is a summary
of the application of the Net Operating Loss carryover on the consolidated return. These
summary grids provide a detailed comparison of each member’s separate company NOL
carryover to the consolidated NOL carryover attributed to it, and show the adjustment, if
any, that needs to be made to member's company 2016 pro forma to reflect any 2015
consolidated NOL adjustments.
They may be exported to an Excel spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you
may elect to have the program use these adjustments to calculate the member’s company
current year NOL deduction. Your original 2016 pro forma’d input will remain unchanged.
Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the
automatic update to be performed. To select this automatic update option, mark the "Adjust
this non-consolidated company’s NOL pro forma based on its prior year consolidated
membership" field on Export > Consolidated Members' NOL Proforma Adjustments > Option to
Adjust Member Companies' Pro Forma. For more information, see help.

Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers
This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income
(Loss) Items workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction
Items workpapers; and Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers.
Workpapers will now cross foot (columns (a) + (b) + (c) = column (d)). Due to laser mask size
constraints only the consolidated amount column was added.

States

We added the ability to e-file state estimate payments for:

Minnesota New York City Tennessee

We added Form 8879-SO, State Signature Forms for:

Alaska Nebraska
Connecticut New Jersey
Delaware New Mexico
Florida North Carolina
Idaho North Dakota
Illinois Rhode Island
Kansas Tennessee
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Maine Texas
Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana

We added State/City electronic filing for:
California Extensions – Stand Alone EFW Payments

Detroit

District of Columbia

Nebraska

New Hampshire

New Consolidated/Combined State Forms
The following forms can now be processed:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

New State Forms
The following forms can now be processed:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)
California Real Estate Withholding Tax Statement (Form 593)
New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum

Arkansas
We added additional supporting statements to Arkansas Schedule K-1.

California
We added the following:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)
California Real Estate Withholding Tax Statement (Form 593)

Georgia
We added Form G-7 NRW, Nonresident Withholding Return (Summer 2016).

Idaho
We added Form 41S, Idaho S corporation Income Tax Return, supporting statement for Other
Items.

Maine
We added Form 1099ME, Pass-Through Withholding.
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Michigan - Detroit
We added the following:

Form 5297 - City of Detroit Corporate Income Tax Return
Form 5298 - City of Detroit Corporate Renaissance Zone Schedule
Form 5299 - City Corporate Income Tax E-file Payment Voucher
Form 5300 - City of Detroit Corporate Income Tax Quarterly Voucher
Form 5301 - Application for Extension of Time to File City Corporate Income Tax Return
Form 5324 - City of Detroit Corporate Income Tax Penalty and Interest Computation for
Underpaid Estimated Tax

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

Ohio
We removed the following:

Form CAT-12
Form FIT-10

Oklahoma
We added 504-C, Application for Extension of Time to File.

Wisconsin
We added the following:

Schedule BD, Business Development Credit
Schedule MT, Alternative Minimum Tax

Tax Product Enhancements 2016.01000 - Interview View • 69



Fiduciary (1041) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Miscellaneous

We reorganized Electronic Filing input and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Depreciation Department Number is now four characters (was two)
(1040/1041/1120/1120S/1065).
We added the 8879-SO (state only) for states without a signature form
(1041/1120/1120S/1065).
We added the ability to file Form 8865 from a 1041 return.
We added the ability to randomly generate the ERO PIN for 1041 returns like we do for 1040
returns.

Letters

We added separate filing instructions and transmittal letters for these items to be used in
future print packages - 2848, 8879, 3520, and 3115 (1041/1120/1120S/1065).
We added "amended" to the form description on the letters for amended returns.
We added “Mail To:” and the mailing address to print at the bottom of extension and
estimates, 7004, 8868. This will not print if the return is selected for electronic filing.
We adjusted all letters and forms for the new Federal (and state) due dates for extended
returns.

Federal Links Worksheet
We added “Autoflow” and "Date Calculated" to the worksheet to be easily used in the DataScans
created.

Drill Downs
We continue adding drill downs for major forms:

Form 8960, Net Investment Income Tax, Line 19a - Adjusted gross income
Schedule B, Interest and Ordinary Dividends, Line 10, Additional modifications (time
available)
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ESBT

We added a QPAI schedule under the ESBT menu (which corrected an issue with the regular
QPAI schedule including ESBT amounts).
We changed the treatment of qualified dividend netting on 4952 to match 1040.

Organizer
Alphabetize K-1s on Organizers. Default is to alphabetize.

States
Automatic inclusion of nonresident state return for e-file when applicable for resident credit for
taxes paid.

Add e-file

Delaware
Rhode Island
South Carolina
Virginia

Arkansas
We added the following:

AR1000TC, Schedule of Tax Credits
AR4-FID, Interest and Dividend Schedule

Arizona
We added the following:

8879-F, Efile Signature Authorization
Form 141AZ V – Payment Voucher

California

We amended returns and extensions can now be filed electronically.
We added CA 8453-FID (PMT) – Payment for Automatic Extension and Estimate Payment
Authorization for Fiduciaries.
We added CA 8879(PMT) – Electronic Funds Withdrawal Payment Signature Authorization for
Individuals and Fiduciaries.

Connecticut
We added the following:

CT-1041 Reminder Sheet, Checklist for Filing your Return
CT-1041V Reminder Sheet, Checklist for Filing your Electronic Filing Payment Voucher

District of Columbia
We added electronic filing estimates.
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Iowa
We added 1041 Schedule I, Alternative Minimum Tax – Estates and Trusts.

Kansas
We added K-41ES – Estimated Voucher.

Michigan

We now calculate credit for income tax paid to other states entered based on the other state
tax rate.
Also, we added a statement on Form MI 1041 to show the calculation for the credit on Line
14a and Line 14b.

North Dakota
We added electronic filing estimates.

Nevada
We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

Form IT-217, Claim for Farmers’ School Tax Credit
Form IT-135, Sales and Use Tax Report for Purchases of Items and Services
IT-112-R, Resident Credit
IT-225, NYS Modifications
IT-1099R, Summary of Federal Form 1099R Statements
electronic filing estimates

Ohio
We added IT K-1, Beneficiary’s Information.

Oklahoma
We added the following:

Oklahoma Electronic Filing (Summer 2016)
Electronic filing estimates
504-C, Application for Extension of Time to File
EF-V, Business Filers Income Tax Payment Voucher

Pennsylvania
We added supporting detail for PA RK-1, Line 6, and NRK-1, Line 4.

Texas
We added 05-158-B FINAL, Franchise Tax Report.
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Wisconsin
We added the following:

Schedule BD, Business Development Credit
Electronic filing estimates
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Employee Benefit Plan (5500) Product Enhancements - Interview
View
Return to Table of Contents.

There are no updates available with this release.
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Exempt Organization (990) Product Enhancements - Interview View
Return to Table of Contents.

Federal

Depreciation Detail Reports
We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font”
Depreciation Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if
the return results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate
bank account information (Summer 2016).

Federal Links Worksheet
We added "Date Calculated" to the worksheet to be easily used in the DataScans created.

Extended Due Dates

Form 8868 has been revised to allow one 6-month automatic extension.
It will no longer be necessary to request a second 3-month extension.

Schedule D/Form 8949
Input has been added for “Quantity” of shares.

Miscellaneous

We reorganized electronic filing and created consistency across systems.
Asset Description is static for summary grid scrolling purposes.
Letters:

We added separate filing instructions and transmittal letters for these items to be
used in future print packages – 114, 2848, and 3115.
We added a new sentence to refer the reader to the Direct Deposit/Debit Report if
that report is included in the return.

A selection can now be made to print the mailing address at the bottom of extension Form
8868. This information will not be printed if the extension has been selected for electronic
filing.

Consistency/Usability Initiative Changes
We revised the menu for logic and consistency.
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States

State Reporting of Grants and Contributions
Federal Interview Form PF-19 now contains state use information fields, Boxes 200 through 219.
These can be used in conjunction with new Interview Form PF-19A to prepare the grants and
contributions statement for California Form 199. It is no longer necessary to provide this
additional information on the California interview forms.

Minnesota
We added the Charitable Trust Annual Report.
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Estate and Gift (706/709) Product Enhancements - Interview View
Return to Table of Contents

Federal
Added new options to prepare Form 8971, Information Regarding Beneficiaries Acquiring Property
From a Decedent.

Overrides are available for the asset description for Form 8971 purposes.
Overrides are available for the percent/amount of an asset that carries to Form 8971.
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